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MSG revision history

Revision Publication date Description

A March 2010 The keyboard for Slovenia, spare part number 494002-BA1, has been added in the
following locations: Computer major components on page 19, Sequential part
number listing on page 28, and Keyboard on page 55.

The graphics card heat sink for use in computer models with nVidia Quadro FX
3700M graphics cards, spare part number 518096-001, has been added in the
following locations: Computer major components on page 19, Sequential part
number listing on page 28, and Graphics card heat sink on page 61

The description for the graphics card heat sink for use in computer models with
nVidia Quadro FX 2700M graphics cards, spare part number 494011-001, has been
updated in the following locations: Computer major components on page 19,
Sequential part number listing on page 28, and Graphics card heat sink
on page 61.

The 500-GB, 7200-rpm hard drive, spare part number 519527-001, and the 500-GB,
5400-rpm hard drive, spare part number 515870-001, have been added in the
following locations: Product description on page 1, Computer major components
on page 19, Sequential part number listing on page 28, and Hard drive
on page 45.

The processors have been updated in the following locations: Product description
on page 1, Computer major components on page 19, Sequential part number
listing on page 28, and Processor on page 68.

The system board for use only in computer models with Core2 Duo processors in
the People's Republic of China and Russia, spare part number 509762-001, and the
system board for use only in computer models with Core2 Quad processors in the
People's Republic of China and Russia, spare part number 509763-001, have been
added in the following locations: Computer major components on page 19,
Sequential part number listing on page 28, and System board on page 85.
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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the
AC adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP EliteBook 8730w Mobile Workstation

Processors Intel® Core™2 Duo processors

 T9600 2.80-GHz processor 6-MB L2 cache, 1066-MHz front side bus (FSB)

 T9400 2.53-GHz processor 6-MB L2 cache, 1066-MHz FSB

 P8600 2.40-GHz processor 3-MB L2 cache, 1066-MHz FSB

 P8400 2.26-GHz processor 3-MB L2 cache, 1066-MHz FSB

 T9550 2.66-GHz processor, 6-MB L2 cache, 1066-MHz FSB

 T9800 2.93-GHz processor, 6-MB L2 cache, 1066-MHz FSB

 T9900 3.06-GHz processor, 6-MB L2 cache, 1066-MHz FSB

 Intel Core2 Quad processors

 Q9100 2.26-GHz processor 12-MB L2 cache, 1066-MHz FSB

 Q9000 2.0-GHz processor 6-MB L2 cache, 1066-MHz FSB

 Intel Core2 Extreme processors

 QX9300 2.53-GHz processor 12-MB L2 cache, 1066-MHz FSB

 X9100 3.06-GHz processor 6-MB L2 cache, 1066-MHz FSB

Chipset Northbridge: Intel PM45 Express Chipset with iAMT 4.0 support

 Southbridge: Intel ICH9M-enhanced

Graphics NVIDIA Quadro FX 3700M (NB9E-GLM3) graphics card with 1-GB graphics subsystem
memory operating at 800 MHz

 NVIDIA Quadro FX 2700M (NB9E-GLM2) graphics card with 512-MB graphics
subsystem memory operating at 800 MHz

 ATI Mobility FireGL V5725 (M86XT-GL) with 256-MB graphics subsystem memory
operating at 800 MHz

 HDMI 1.3 Compliant

 OpenGL driver support

Panels 17.0-inch WUXGA WVA AntiGlare display assembly

 17.0-inch WUXGA WVA AntiGlare display assembly

 17.0-inch WSXGA+ WVA AntiGlare display assembly
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Category Description

 17.0-inch WUXGA DreamColor display assembly

 17.0-inch WXGA+ AnitGlare display assembly

Memory 2 customer-accessible/upgradable memory module slots

 Supports dual-channel memory

 Supports up to 8 GB of system RAM

 PC2-6400, 800-MHz, DDR2

 Supports the following configurations:

● 8192-MB total system memory (4096 × 2, dual-channel)

● 6144-MB total system memory (4096 + 2048)

● 5120-MB total system memory (4096 + 1024)

● 4096-MB total system memory (2048 × 2, dual channel)

● 4096-MB total system memory (4096 × 1)

● 3072-MB total system memory (2048 + 1024)

● 2048-MB total system memory (1024 × 2, dual-channel)

● 2048-MB total system memory (2048 × 1)

● 1024-MB total system memory (1024 × 1)

Hard drives Supports 9.5-mm 2.5-inch hard drives

 Customer-accessible

 Serial ATA

 Supports the following drives:

● 500-GB, 7200 and 5400 rpm

● 320-GB, 7200 rpm

● 250-GB, 7200 and 5400 rpm

● 160-GB, 7200 and 5400 rpm

● 80-GB solid state drive

 HP 3D Drive Guard

Optical drives Upgrade bay (removal of 1 screw required)

 Customer-accessible

 Serial ATA

 12.7-mm tray load

 Supports the following drives:

● DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe

● Blu-ray ROM DVD+/-RW SuperMulti DL Drive

● DVD-ROM Drive
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Category Description

Diskette drive Supports external USB diskette drive only

 Supports boot from external USB diskette drive

Microphone Integrated dual-array microphone

Audio ADI1984A HD Audio

Modem 56K V.92 1.5-inch data/fax modem with digital line guard

 HD audio interface

 Modem cable not included

Ethernet Intel 82567LM 10/100/1000 network interface card (NIC) with iAMT

 S3/S4/S5 wake on LAN: DC - no

 S3/S4/S5 wake on LAN: AC - yes

 NIC power-down technology

Wireless Integrated WLAN options by way of wireless module:

 Three WLAN antennae built into display assembly

 Support for no-WLAN option

 Support for the following WLAN formats:

● Intel 802.11a/b/g/n

● Intel 802.11a/b/g/n with iAMT support

● Intel 802.11a/b/g

● Intel 802.11a/b/g with iAMT support

 Integrated personal area network (PAN) options by way of Bluetooth® module:

 Support for no-WPAN option

 Broadcom Bluetooth

External media cards One ExpressCard/54 slot

 Media Card Reader supporting Secure Digital (SD) Memory Card, MultiMediaCard
(MMC), Memory Stick (MS), Memory Stick Pro (MSP), xD-Picture Card (XD) and Memory
Stick Duo

Ports Audio-in (mono microphone)

 Audio-out (stereo headphone)

 High-Definition Multimedia Interface (HDMI)

 eSATA

 RJ-11 (modem)

 RJ-45 (Ethernet, includes link and activity lights)

 USB (4)

 VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at 75-Hz (hot plug/unplug
with auto-detect)
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Category Description

 3-pin AC power

Docking HP Advanced Docking Station and HP Docking Station

Keyboard/pointing devices 14.4-inch keyboard with separate numeric keypad

 Dualpoint (pointing stick and TouchPad) with 3 pointing stick buttons and 3 TouchPad
buttons and vertical scrolling (taps enabled as default)

Power requirements The following AC adapters with localized cable plug support (3-wire plug with ground pin,
supports 3-pin DC connector):

● 150-W PFC AC adapter

● 120-W PFC AC adapter

 8-cell, 2.55-Ah (73-Wh) Li-ion battery

 Support for 8-cell Extended Life Battery

 Support for 12-cell Ultra Capacity Battery

Security Full volume encryption

 Integrated fingerprint reader

 Integrated smart card reader

 Preboot authentication (password, smart card)

 Security cable slot

 Trusted platform module (TPM) V.1.2

Operating system Preinstalled:

 Windows Vista® Business 32/64

 Windows Vista Home Basic 32

 Windows® XP Professional

 FreeDOS

 Preinstalled with Microsoft® Office:

 Windows Vista Business 32/64 with Office 2007 Ready

 Windows Vista Business 32/64 with Office 2007 Personal

 Windows Vista Business 32/64 with Office 2007 Pro

 Windows Home Basic with Office 2007 Ready

 Windows Vista Ultimate with Office 2007 Ready

 Windows XP Professional with Office 2007 Ready

 Windows XP Professional with Office 2007 Personal

 Windows XP Professional with Office 2007 Pro

 Restore media:

 Windows Vista Business 32/64

 Windows Vista Home Basic 32
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Category Description

 Windows Ultimate 32

 Windows XP Professional

 DRDVD Windows XP Pro

 DRDVD Windows Vista

 Supported:

 Window XP Professional 64 (SP2)

 Certified:

 Novell SuSE Linux

Serviceability End-user replaceable parts:

 AC adapter

 Battery (system)

 Hard drive

 Memory module

 Optical drive

 WLAN module

 Bluetooth module

 Keyboard

 RTC battery

 Fan assembly

 Power button

 Switch cover
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2 External component identification

Display

Component Description

(1) Internal display switch Turns off the display if the display is closed while the power is on.

(2) Internal microphones (2) Record sound.

(3) Webcam light On: The webcam is in use.

(4) Webcam Records audio and video and captures still photographs.

(5) Ambient light sensor Automatically adjusts the display brightness based on the lighting
conditions in your environment.

6 Chapter 2   External component identification



Top components

Pointing devices

Component Description

(1) Pointing stick* Moves the pointer and selects or activates items on the screen.

(2) Left pointing stick button* Functions like the left button on an external mouse.

(3) TouchPad* Moves the pointer and selects or activates items on the screen.

(4) Left TouchPad button* Functions like the left button on an external mouse.

(5) Center TouchPad button* Functions like the center button on an external mouse.

(6) Right TouchPad button* Functions like the right button on an external mouse.

(7) TouchPad scroll zone Scrolls up or down.

(8) Right pointing stick button* Functions like the right button on an external mouse.

(9) Center pointing stick button* Functions like the center button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences, follow these steps:

● In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.
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Lights

Component Description

(1) Power lights (2)* ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows Vista)
or Standby (Windows XP).

● Off: The computer is off or in Hibernation.

(2) Wireless lights (2)† ● On: An integrated wireless device, such as a wireless local
area network (WLAN) device and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(3) Caps lock light On: Caps lock is on.

(4) Num lock light On: Num lock is on.

(5) Volume mute light ● On: Computer sound is on.

● Amber: Computer sound is off.

(6) Volume down light Blinking: The volume scroll zone is being used to decrease speaker
volume.

(7) Volume up light Blinking: The volume scroll zone is being used to increase speaker
volume.

(8) Calculator light On: The Windows calculator function is on.
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Component Description

(9) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins blinking
rapidly.

● Off: If the computer is plugged into an external power source,
the light turns off when all batteries in the computer are fully
charged. If the computer is not plugged into an external power
source, the light stays off until the battery reaches a low
battery level.

(10) Drive light ● Blinking: The hard drive or optical drive is being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the hard
drive.

*The 2 power lights display the same information. The light on the power button is visible only when the computer is open. The
power light on the front of the computer is visible whether the computer is open or closed.

†The 2 wireless lights display the same information. The light on the wireless button is visible only when the computer is open.
The wireless light on the front of the computer is visible whether the computer is open or closed.
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Buttons, switches, and fingerprint reader

Component Description

(1) Power button ● When the computer is off, press the button to turn on the
computer.

● When the computer is on, press the button to shut down the
computer.

● When the computer is in the Sleep state (Windows Vista) or
Standby (Windows XP), press the button briefly to exit Sleep
or Standby.

● When the computer is in Hibernation, press the button briefly
to exit Hibernation.

If the computer has stopped responding and Windows shutdown
procedures are ineffective, press and hold the power button for at
least 5 seconds to turn off the computer.

To learn more about your power settings, follow these steps:

● In Windows Vista, select Start > Control Panel > System
and Maintenance > Power Options.

● In Windows XP, select Start > Control Panel > Performance
and Maintenance > Power Options.

(2) Info button Launches Info Center, which enables you to open various software
solutions.

(3) Internal display switch Turns off the display if the display is closed while the power is on.
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Component Description

(4) Wireless button Turns the wireless feature on or off but does not establish a
wireless connection.

NOTE: You must set up or access a wireless network to establish
a wireless connection.

(5) Presentation button Starts the presentation feature.

(6) Volume mute button Mutes and restores speaker sound.

(7) Volume scroll zone Adjusts speaker volume. Slide your finger to the left to decrease
volume and to the right to increase volume. You can also press the
left side of the volume slider to decrease volume, or press the right
side of the volume slider to increase volume.

(8) Calculator button Turns on the Windows calculator function.

(9) Fingerprint reader Allows a fingerprint logon to Windows instead of a password logon.
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Keys

NOTE: Your computer may look slightly different from the illustration in this section.

Component Description

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Integrated numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.
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Front components

Component Description

(1) Wireless light On: An integrated wireless device, such as a wireless local area
network (WLAN) device and/or a Bluetooth device, is on.

Amber: All wireless devices are off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows Vista)
or Standby (Windows XP).

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins blinking
rapidly.

● Off: If the computer is plugged into an external power source,
the light turns off when all batteries in the computer are fully
charged. If the computer is not plugged into an external power
source, the light stays off until the battery reaches a low
battery level.

(4) Drive light Blinking: The hard drive or optical drive is being accessed.

Amber: HP 3D DriveGuard has temporarily parked the hard drive.

(5) Speakers (2) Produce sound.

(6) Audio-out (headphone) jack Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(7) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.
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Component Description

(8) Media Card Reader Supports the following optional digital card formats:

● Memory Stick

● Memory Stick Duo

● Memory Stick Pro

● MultiMediaCard

● Secure Digital Memory Card

● xD-Picture Card

● xD-Picture Card Type H

● xD-Picture Card Type M

(9) Display release button Opens the computer.

(10) Business card slot Holds a business card in position so that the webcam can capture
an image.

Left-side components

Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.

(2) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(3) Power connector Connects an AC adapter.

(4) HDMI port Connects an optional HDMI device.

(5) External monitor port Connects an external VGA monitor or projector.

(6) USB port Connects an optional USB device.

(7) 1394 port Connects an optional IEEE 1394 or 1394a device, such as a
camcorder.

(8) ExpressCard slot Supports optional ExpressCards.

(9) Smart card reader Supports optional smart cards and Java™ Cards.
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Rear component

The vent enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal components and prevent overheating.
It is normal for the internal fan to cycle on and off during routine operation.

Right-side components

Component Description

(1) eSATA port Connects high-performance eSATA components, such as an
eSATA external hard drive.

(2) USB ports (3) Connect optional USB devices.

(3) Upgrade bay Supports an optical drive or hard drive.

(4) RJ-45 (network) jack Connects a network cable.

(5) RJ-11 (modem) jack Connects a modem cable.
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Bottom components

Component Description

(1) Battery bay Holds the battery.

(2) Docking connector Connects an optional docking device.

(3) Vents (3) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(4) Hard drive bay Holds the hard drive and a Bluetooth device.

(5) Memory module compartment Contains the memory module slots and a wireless LAN module
slot.

CAUTION: To prevent an unresponsive system and the display
of a warning message, replace the WLAN module with only a
module authorized for use in the computer by the governmental
agency that regulates wireless devices in your country. If you
replace the module and then receive a warning message, remove
the module to restore computer functionality, and then contact
technical support through Help and Support.

(6) Accessory battery connector Connects an optional accessory battery.

(7) Battery release latch Releases the battery from the battery bay.
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Wireless antennae
The antennae send and receive signals from one or more wireless devices. These antennae are not
visible from the outside of the computer.

NOTE: For optimal transmission, keep the areas immediately around the antennae free from
obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.

Wireless antennae 17



3 Illustrated parts catalog

Service tag
The service tag, affixed to the bottom of the computer, provides information that may be needed when
troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for the
computer.

(5) Warranty period: This number describes the duration of the warranty period for this computer.

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
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Item Description Spare part number

(1) Display assemblies (include 3 WLAN antenna transceivers and cables)

 17.0-inch WUXGA WVA AntiGlare display assembly without camera module 494016-001

 17.0-inch WUXGA WVA AntiGlare display assembly with camera module 494017-001

 17.0-inch WSXGA+ WVA AntiGlare display assembly without camera module 494012-001

 17.0-inch WSXGA+ WVA AntiGlare display assembly with camera module 494013-001

 17.0-inch WUXGA DreamColor display assembly without camera module 494014-001

 17.0-inch WUXGA DreamColor display assembly with camera module 494015-001

 17.0-inch WXGA+ AnitGlare display assembly without camera module 494018-001

 17.0-inch WXGA+ AnitGlare display assembly with camera module 494019-001

(2) Keyboards with pointing stick (include keyboard cable and pointing stick cable)

 For use in Belgium 494002-A41

 For use in Brazil 494002-201

 For use in the Czech Republic 494002-221

 For use in Denmark 494002-081

 For use in France 494002-051

 For use in French Canada 494002-121

 For use in Germany 494002-041

 For use in Greece 494002-151

 For use in Hungary 494002-211

 For use in Iceland 494002-DD1

 For use in Israel 494002-BB1

 For use in Italy 494002-061

 For use in Japan 494002-291

 For use in Latin America 494002-161

 For use in the Netherlands and Europe 494002-021

 For use in Norway 494002-091

 For use in Portugal 494002-131

 For use in Russia 494002-251

 For use in Saudi Arabia 494002-171

 For use in Slovakia 494002-231

 For use in Slovenia 494002-BA1

 For use in South Korea 494002-AD1

 For use in Spain 494002-071

 For use in Sweden and Finland 494002-B71
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Item Description Spare part number

 For use in Switzerland 494002-111

 For use in Taiwan 494002-AB1

 For use in Thailand 494002-281

 For use in Turkey 494002-141

 For use in the United Kingdom 494002-031

 For use in the United States 494002-001

(3) Switch cover (includes LED board and cable and power button board) 493986-001

(4) Top cover (includes TouchPad, TouchPad bracket, TouchPad cable, fingerprint reader board
and cable)

493987-001

(5) Fan 494000-001

(6) Graphics card heat sink  

 For use in computer models with nVidia Quadro FX 2700M graphics cards 494011-001

 For use in computer models with nVidia Quadro FX 3700M graphics cards 518096-001

 For use in computer models with ATI graphics cards 494211-001

(7) Hard drives (include hard drive bracket and screws)

 500-GB, 7200-rpm 519527-001

 500-GB, 5400-rpm 515870-001

 320-GB, 7200-rpm 493997-001

 250-GB, 7200-rpm 493996-001

 250-GB, 5400-rpm 493994-001

 160-GB, 7200-rpm 493992-001

 160-GB, 5400-rpm 493991-001

 80-GB, solid state drive (not illustrated) 493998-001

(8) Graphics cards (include replacement thermal material)

 ATI Mobility FireGL V5725 493982-001

 nVidia Quadro FX 2700M 493983-001

 nVidia Quadro FX 3700M 493984-001

(9) Bluetooth module (includes Bluetooth module cable) 398393-002

(10) Heat sink assemblies (include replacement thermal material)

 For use only with computer models equipped with the following processors: P8400, P8600,
T9400, and T9600

494010-001

 For use only with computer models equipped with the following processors: X9100, Q9100,
and QX9300

494210-001

(11) USB/eSATA board (includes cable) 493981-001

(12) Modem modules  
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Item Description Spare part number

 For use in all countries and regions except for Australia and New Zealand 461750-001

 For use only in Australia and New Zealand 461750-011

(13) Speaker assembly 494029-001

(14) Media card reader/audio board 493978-001

(15) Optical drives

 DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe 493990-001

 Blu-ray ROM DVD+/-RW SuperMulti DL Drive 493989-001

 DVD-ROM Drive 493988-001

(16) Intel Core2 Extreme processors (include replacement thermal material)  

 QX9300 2.53-GHz processor (12-MB L2 cache, 1066-MHz FSB) 507946-001

 X9100 3.06-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507950-001

 Intel Core2 Quad processors (include replacement thermal material)  

 Q9100 2.26-GHz processor (12-MB L2 cache, 1066-MHz FSB) 507947-001

 Q9000 2.0-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507948-001

 Intel Core2 Duo processors (include replacement thermal material)  

 T9900 3.06-GHz processor (6-MB L2 cache, 1066-MHz FSB) 570434-001

 T9800 2.93-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507951-001

 T9600 2.8-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507955-002

 T9550 2.66-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507953-001

 T9400 2.53-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507956-002

 P8600 2.4-GHz processor (3-MB L2 cache, 1066-MHz FSB) 507963-002

 P8400 2.26-GHz processor (3-MB L2 cache, 1066-MHz FSB) 507964-002

(17) System boards (include replacement thermal material)

 For use in computer models with dual core processors (includes RTC battery) 493980-001

 For use in computer models with quad core processors (includes RTC battery) 501508-001

 For use only in computer models with Core2 Duo processors in the People's Republic of China
and Russia (includes RTC battery)

509762-001

 For use only in computer models with Core2 Quad processors in the People's Republic of
China and Russia (includes RTC battery)

509763-001

(18) Memory modules

 4096-MB memory module (PC2-6400, 800-MHz, DDR2) 494009-001

 2048-MB memory module (PC2-6400, 800-MHz, DDR2) 494008-001

 1024-MB memory module (PC2-6400, 800-MHz, DDR2) 494007-001

(19) ExpressCard assembly 493999-001

(20) WLAN modules
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Item Description Spare part number

 For use in non-iAMT (Intel Active Management Technology) models:  

 ● Intel WiFi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions
except for Russia, Ukraine, and Pakistan

480985-001

 ● Intel WiFi Link 5100 802.11a/b/g WLAN module for use in Russia, Ukraine, and Pakistan 482957-001

 ● Intel WiFi Link 5300 802.11a/b/g/n WLAN module for use in all countries and regions 480986-001

 For use in iAMT models:  

 ● Intel WiFi Link 5100 802.11a/b/g/n for iAMT WLAN module for use in all countries and
regions except for Russia, Ukraine, and Pakistan

506678-001

 ● Intel WiFi Link 5100 802.11a/b/g for iAMT WLAN module for use in Russia, Ukraine, and
Pakistan

506680-001

 ● Intel WiFi Link 5300 802.11a/b/g/n for iAMT WLAN module for use in all countries and
regions

506679-001

(21) 8-cell, 2.55-Ah, Li-ion battery 493976-001

(22) Base enclosure (includes latch assembly) 493975-001

 Plastics Kit (see Plastics Kit on page 25 for more Plastics Kit spare part information): 494020-001

(23a) Hard drive cover (includes 2 captive screws, secured by C-clips)

(23b) Memory module/WLAN module compartment cover (includes one captive screw, secured by a C-clip)

(23c) ExpressCard slot bezel

(23d) Bluetooth compartment cover

 Rubber Kit (includes 8 feet in 2 different sizes) 494027-001

 Cable Kit (not illustrated; see Cable Kit on page 25 for more Cable Kit spare part number
information)

493985-001
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Display assembly components

Item Description Spare part number

(1) Display bezels  

 For use only in computer models without a camera module 494003-001

 For use only in computer models with a camera module 487285-001

(2) Display inverter for use only in models with an LCD display (includes Mylar shield) 494001-001

 Ambient light sensor board for use only in models with a DreamColor LED display –
494014-001 and 494015-001 (not illustrated)

495029-001

(3) Display cable  

 For use only in computer models with a DreamColor LED display 495607-001

 For use only in computer models with an LCD display 494005-001
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Item Description Spare part number

(4) Camera module (includes flex cable) 494030-001

(5) Display Hinge Kit (includes hinge covers) 494004-001

(6) Display enclosure (includes wireless antennae and microphone)  

 For use only in computer models with a DreamColor LED display 495895-001

 For use only in computer models with an LCD display 494006-001

Plastics Kit

Item Description Spare part number

 Plastics Kit: 494020-001

(1) Hard drive compartment cover (includes 2 captive screws, secured by C-clips)

(2) Memory module/WLAN module compartment cover (includes 3 captive screws, secured by C-clips)

(3) Bluetooth compartment cover

(4) ExpressCard slot bezel

Cable Kit
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Item Description Spare part number

 Cable Kit: 493985-001

(1) RJ-45 jack cable

(2) RJ-11 jack cable

(3) Bluetooth cable

(4) Microphone extension cable
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Mass storage devices

Item Description Spare part number

(1) Hard drives (include bracket and screws)

 320-GB, 7200-rpm 493997-001

 250-GB, 7200-rpm 493996-001

 250-GB, 5400-rpm 493994-001

 160-GB, 7200-rpm 493992-001

 160-GB, 5400-rpm 493991-001

 Solid state drive, 80 GB (not illustrated) 493998-001

(2) Optical drives (include bezel)

 DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe 493990-001

 Blu-ray ROM DVD+/-RW SuperMulti DL Drive 493989-001

 DVD-ROM Drive 493988-001

Miscellaneous parts

Description Spare part number

AC adapters

150-W PFC AC adapter 463954-001

120-W PFC AC adapter 463953-001

Power cords:

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-201

For use in Denmark 490371-081

For use in Europe, the Middle East, and Africa 490371-021

For use in India 490371-D61
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Description Spare part number

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in the United Kingdom 490371-031

For use in the United States 490371-001

Screw Kit

● Phillips PM2.5×2.5 screw

● Phillips PM2.5×3.0 screw

● Phillips PM2.5×4.5 screw

● Phillips PM2.0×3.0 screw

● Torx T8M2.5×8.0 screw

● Torx T8M2.5×4.0 screw

494028-001

Sequential part number listing

Spare part
number

Description

398393-002 Bluetooth module (includes Bluetooth module cable)

449137-001 RTC battery

461750-001 Modem module for use in all countries and regions except for Australia and New Zealand

461750-011 Modem module for use only in Australia and New Zealand

463953-001 120-W PFC AC adapter

463954-001 150-W PFC AC adapter

480985-001 Intel WiFi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions except for Russia,
Ukraine, and Pakistan

480986-001 Intel WiFi Link 5300 802.11a/b/g/n WLAN module for use in all countries and regions

482957-001 Intel WiFi Link 5100 802.11a/b/g WLAN module for use in Russia, Ukraine, and Pakistan

490371-001 Power cord (3-wire) for use in North America

490371-011 Power cord (3-wire) for use in Australia

490371-021 Power cord (3-wire) for use in Europe, the Middle East, and Africa
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Spare part
number

Description

490371-031 Power cord (3-wire) for use in the United Kingdom

490371-061 Power cord (3-wire) for use in Italy

490371-081 Power cord (3-wire) for use in Denmark

490371-111 Power cord (3-wire) for use in Switzerland

490371-201 Power cord (3-wire) for use in Brazil

490371-291 Power cord (3-wire) for use in Japan

490371-AA1 Power cord (3-wire) for use in the People's Republic of China

490371-AB1 Power cord (3-wire) for use in Taiwan

490371-AD1 Power cord (3-wire) for use in South Korea

490371-AR1 Power cord (3-wire) for use in South Africa

490371-BB1 Power cord (3-wire) for use in Israel

490371-D01 Power cord (3-wire) for use in Argentina

490371-D61 Power cord (3-wire) for use in India

493975-001 Base enclosure (includes latch assembly)

493976-001 Battery, 8-cell, 2.55-Ah, Li-ion

493978-001 Media card reader/audio board

493980-001 System board for use in computer models with dual core processors (includes RTC battery and replacement
thermal material)

493981-001 USB/eSATA board (includes cable)

493982-001 ATI Mobility FireGL V5725 graphics card; includes replacement thermal material

493983-001 nVidia Quadro FX 2700M graphics card; includes replacement thermal material

493984-001 nVidia Quadro FX 3700M graphics card; includes replacement thermal material

493985-001 Cable Kit (see Cable Kit on page 25 for more Cable Kit spare part information

493986-001 Switch cover (includes LED board and cable and power button board)

493987-001 Top cover (includes TouchPad, TouchPad bracket, TouchPad cable, fingerprint reader board and cable)

493988-001 DVD-ROM drive

493989-001 Blu-ray ROM DVD+/-RW SuperMulti DL Drive

493990-001 DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe

493991-001 160-GB, 5400-rpm hard drive (includes hard drive bracket and screws)

493992-001 160-GB, 7200-rpm hard drive (includes hard drive bracket and screws)

493994-001 250-GB, 5400-rpm hard drive (includes hard drive bracket and screws)

493996-001 250-GB, 7200-rpm hard drive (includes hard drive bracket and screws)

493997-001 320-GB, 7200-rpm hard drive (includes hard drive bracket and screws)

493998-001 80-GB, solid state drive (includes hard drive bracket and screws)
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Spare part
number

Description

493999-001 ExpressCard assembly

494000-001 Fan

494001-001 Display inverter for use only in models with an LCD display (includes Mylar shield)

494002-001 Keyboard with pointing stick for use in the United States

494002-021 Keyboard for use in Europe

494002-031 Keyboard for use in the United Kingdom

494002-041 Keyboard for use in Germany

494002-051 Keyboard for use in France

494002-061 Keyboard for use in Italy

494002-071 Keyboard for use in Spain

494002-081 Keyboard for use in Denmark

494002-091 Keyboard for use in Norway

494002-111 Keyboard for use in Switzerland

494002-121 Keyboard for use in French Canada

494002-131 Keyboard for use in Portugal

494002-141 Keyboard for use in Turkey

494002-151 Keyboard for use in Greece

494002-161 Keyboard for use in Latin America

494002-171 Keyboard for use in Saudi Arabia

494002-201 Keyboard for use in Brazil

494002-211 Keyboard for use in Hungary

494002-221 Keyboard for use in the Czech Republic

494002-231 Keyboard for use in Slovakia

494002-251 Keyboard for use in Russia

494002-281 Keyboard for use in Thailand

494002-291 Keyboard for use in Japan

494002-A41 Keyboard for use in Belgium

494002-AB1 Keyboard for use in Taiwan

494002-AD1 Keyboard for use in South Korea

494002-B71 Keyboard for use in Sweden and Finland

494002-BA1 Keyboard for use in Slovenia

494002-BB1 Keyboard for use in Israel

494002-DD1 Keyboard for use in Iceland

494003-001 Display bezel for use in computer models without a camera module
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Spare part
number

Description

494004-001 Display Bracket Kit (includes hinge covers)

494005-001 Display panel cable for use in computer models with LCD displays

494006-001 Display enclosure for use in computer models with LCD displays (includes wireless antennae and microphone)

494007-001 1024-MB memory module (PC-6400, 800-GHz, DDR2)

494008-001 2048-MB memory module (PC-6400, 800-GHz, DDR2)

494009-001 4096-MB memory module (PC2-6400, 800-MHz, DDR2)

494010-001 Heat sink for use only with computer models equipped with the following processors: P8400, P8600, T9400,
and T9600 (includes replacement thermal material)

494011-001 Graphics card heat sink for use in computer models with nVidia Quadro FX 2700M graphics cards

494012-001 17.0-inch, WSXGA+ WVA AntiGlare display assembly without camera module (includes 3 WLAN antenna
transceivers and cables)

494013-001 17.0-inch, WSXGA+ WVA AntiGlare display assembly with camera module (includes 3 WLAN antenna
transceivers and cables)

494014-001 17.0-inch, WUXGA DreamColor display assembly without camera module (includes 3 WLAN antenna
transceivers and cables)

494015-001 17.0-inch, WUXGA DreamColor display assembly with camera module (includes 3 WLAN antenna
transceivers and cables)

494016-001 17.0-inch, WUXGA+ WVA AntiGlare display assembly without camera module (includes 3 WLAN antenna
transceivers and cables)

494017-001 17.0-inch, WUXGA+ WVA AntiGlare display assembly with camera module (includes 3 WLAN antenna
transceivers and cables)

494018-001 17.0-inch, WXGA+ AntiGlare display assembly without camera module (includes 3 WLAN antenna
transceivers and cables)

494019-001 17.0-inch, WXGA+ AntiGlare display assembly with camera module (includes 3 WLAN antenna transceivers
and cables)

494020-001 Plastics Kit (see Plastics Kit on page 25 for more Plastics Kit spare part information)

494027-001 Rubber Kit (includes 8 feet in 2 different sizes)

494028-001 Screw Kit

494029-001 Speaker assembly

494030-001 Camera module (includes flex cable)

494210-001 Heat sink for use only with computer models equipped with the following processors: X9100, Q9100, and
QX9300 (includes replacement thermal material)

494211-001 Graphics card heat sink for use in computer models with ATI graphics cards

495029-001 Ambient light sensor board (for use only in models with a DreamColor LED display – 494014-001 and
494015-001)

495030-001 Display bezel for use in computer models with a camera module

495607-001 Display panel cable for use in computer models with DreamColor LED displays

495895-001 Display enclosure for use in computer models with DreamColor LED displays (includes wireless antennae and
microphone)
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Spare part
number

Description

501508-001 System board for use only with computer models equipped with quad core processors (includes RTC battery
and replacement thermal material)

506678-001 Intel WiFi Link 5100 802.11a/b/g/n for iAMT WLAN module for use in all countries and regions except for
Russia, Ukraine, and Pakistan

506679-001 Intel WiFi Link 5300 802.11a/b/g/n for iAMT WLAN module for use in all countries and regions

506680-001 Intel WiFi Link 5100 802.11a/b/g for iAMT WLAN module for use in Russia, Ukraine, and Pakistan

507946-001 Intel Core2 Extreme QX9300 2.53-GHz processor (12-MB L2 cache, 1066-MHz FSB; includes replacement
thermal material)

507947-001 Intel Core2 Quad Q9100 2.26-GHz processor (12-MB L2 cache, 1066-MHz FSB; includes replacement thermal
material)

507948-001 Intel Core2 Quad Q9000 2.0-GHz processor (6-MB L2 cache, 1066-MHz FSB; includes replacement thermal
material)

507950-001 Intel Core2 Extreme X9100 3.06-GHz processor (6-MB L2 cache, 1066-MHz FSB; includes replacement
thermal material)

507951-001 Intel Core2 Duo T9800 2.93-GHz processor (6-MB L2 cache, 1066-MHz FSB; includes replacement thermal
material)

507953-001 Intel Core2 Duo T9550 2.66-GHz processor (6-MB L2 cache, 1066-MHz FSB; includes replacement thermal
material)

507955-002 Intel Core2 Duo T9600 2.80-GHz processor (6-MB L2 cache, 1066-MHz FSB; includes replacement thermal
material)

507956-002 Intel Core2 Duo T9400 2.53-GHz processor (6-MB L2 cache, 1066-MHz FSB; includes replacement thermal
material)

507963-002 Intel Core2 Duo MV P8600 2.40-GHz processor (3-MB L2 cache, 1066-MHz FSB; includes replacement
thermal material)

507964-002 Intel Core2 Duo MV P8400 2.26-GHz processor (3-MB L2 cache, 1066-MHz FSB; includes replacement
thermal material)

509762-001 System board for use only in computer models with Core2 Duo processors in the People's Republic of China
and Russia (includes RTC battery)

509763-001 System board for use only in computer models with Core2 Quad processors in the People's Republic of China
and Russia (includes RTC battery)

515870-001 500-GB, 5400-rpm hard drive (includes hard drive bracket and screws)

518096-001 Graphics card heat sink for use in computer models with nVidia Quadro FX 3700M graphics cards

519527-001 500-GB, 7200-rpm hard drive (includes hard drive bracket and screws)

570434-001 Intel Core2 Duo T9900 3.06-GHz processor (6-MB L2 cache, 1066-MHz FSB; includes replacement thermal
material)
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
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Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials are
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V

Preliminary replacement requirements 37



Unknown user password

NOTE: This process will not work if Stringent Security is enabled in F10 Setup. Stringent Security
installs passwords into the ROM so that it is not affected when the RTC battery is removed.

If the computer you are servicing has an unknown user password, follow these steps to clear the
password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 58).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 86 screws in 12 different sizes that must be removed, replaced, or loosened when
servicing the computer. Make special note of each screw size and location during removal and
replacement.

Serial number

Report the computer serial number to HP when requesting information or ordering spare parts. The
serial number is located on the bottom of the computer.

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for the
computer.

(5) Warranty period: This number describes the duration of the warranty period for this computer.

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
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Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 494027-001. There are 9 rubber feet in 2 different sizes that attach to the base enclosure
in the locations illustrated below.
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Battery

Description Spare part number

8-cell, 2.55-Ah, Li-ion battery 493976-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Display inverter or ambient light sensor

NOTE: If it has been determined that the display inverter must be replaced to complete the computer
repair, the display assembly does not have to be removed. Follow the procedures in this section to
replace the display inverter. For information on replacing the display assembly, the display hinges, or
the display bezel, see Display assembly on page 70.

NOTE: The display inverter and the ambient light sensor are installed in the same location. The only
difference in removal and replacement is the ambient light sensor does not include a backlight cable
connector, while the inverter does. Models with LCD displays use the inverter, while models with
DreamColor LED displays use the ambient light sensor.

Description Spare part number

Display inverter for use only in models with an LCD display (includes Mylar shield) 494001-001

Ambient light sensor for use only in models with a DreamColor LED display – 494014-001 and
494015-001

495029-001

Before removing the display inverter or ambient light sensor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the display inverter or ambient light sensor:

1. Turn the computer right-side up, with the front toward you.

2. Open the computer as far as possible.
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3. Remove the six screw covers (1) and six Torx T8M2.5×6.0 screws (2) that secure the display bezel
to the display enclosure.

4. Flex the display bezel bottom edge (1), the inside edges of the left and right sides (2), and then the
display bezel top edge (3) until the bezel disengages from the display assembly.

5. Lift the display bezel straight up (4) to remove it from the display assembly.

NOTE: There are two posts that protrude through two holes on the top edge of the bezel. So that
you do not break the posts, be sure to lift the bezel straight up when removing it from the display
assembly.

6. Remove the Torx T8M2.5×6.0 screw (1) that secures the display inverter or ambient light sensor
to the display enclosure.

7. Release the inverter or sensor (2) from the display enclosure as far as the display panel cable and/
or backlight cable allow.

NOTE: Models with a DreamColor LED display use the ambient light sensor which does not have
a backlight cable connector.
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8. Disconnect the display panel cable (3) and the backlight cable (inverter only) (4) from the display
inverter or ambient light sensor.

9. Remove the display inverter or ambient light sensor (5).

Reverse this procedure to install the display inverter or ambient light sensor.
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Hard drive

NOTE: The hard drive spare part kit includes the hard drive bracket and screws.

Description Spare part number

500-GB, 7200-rpm hard drive 519527-001

500-GB, 5400-rpm hard drive 515870-001

320-GB, 7200-rpm hard drive 493997-001

250-GB, 7200-rpm hard drive 493996-001

250-GB, 5400-rpm hard drive 493994-001

160-GB, 7200-rpm hard drive 493992-001

160-GB, 5400-rpm hard drive 493991-001

80-GB, solid state drive 493998-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0×5.0 captive screws (1) that secure the hard drive cover to the
computer.
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3. Lift the right side of the hard drive cover (2), swing it to left, and remove the cover. The hard drive
cover is included in the Plastics Kit, spare part number 494020-001.

4. Loosen the Phillips PM2.5×11.0 captive screw (1) that secures the hard drive to the computer.

5. Grasp the Mylar tab (2) on the hard drive and slide the hard drive (3) to the right to disconnect it
from the system board.

6. Remove the hard drive (4) from the hard drive bay.

7. If it is necessary to replace the hard drive bracket, remove the two Phillips PM3.0×4.0 hard drive
bracket screws (1) from each side of the hard drive.
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8. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Bluetooth module

Description Spare part number

Bluetooth module (includes Bluetooth module cable) 398393-002

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the Bluetooth module:

1. Position the computer upside down with the front toward you.

2. Lift the back of the Bluetooth compartment cover up, and then lift the cover up and off the computer
(1).

NOTE: The Bluetooth compartment cover is available in the Plastics Kit, spare part number
494020-001.

3. Lift and remove the Bluetooth module (2) from the compartment by lifting it straight up.

4. Disconnect the Bluetooth module cable (3) from the Bluetooth module.

Reverse this procedure to reassemble and install the Bluetooth module.

48 Chapter 4   Removal and replacement procedures



Memory module

Description Spare part number

4096-MB (PC2-6400, 800-MHz, DDR2) 494009-001

2048-MB (PC2-6400, 800-MHz, DDR2) 494008-001

1024-MB (PC2-6400, 800-MHz, DDR2) 494007-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the memory module:

1. Loosen the Phillips PM2.5×5.0 captive screw (1) that secures the memory module/WLAN module
compartment cover to the computer.

2. Lift the front edge of the cover, swing it up and forward (2), and then remove the cover. The memory
module/WLAN module compartment cover is included in the Plastics Kit, spare part number
494020-001.

3. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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4. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install the memory module.
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WLAN module

Description Spare part number

For use in non-iAMT models:  

Intel WiFi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions except for
Russia, Ukraine, and Pakistan

480985-001

Intel WiFi Link 5100 802.11a/b/g WLAN module for use in Russia, Ukraine, and Pakistan 482957-001

Intel WiFi Link 5300 802.11a/b/g/n WLAN module for use in all countries and regions 480986-001

For use in iAMT models:  

Intel WiFi Link 5100 802.11a/b/g/n for iAMT WLAN module for use in all countries and regions except
for Russia, Ukraine, and Pakistan

506678-001

Intel WiFi Link 5100 802.11a/b/g for iAMT WLAN module for use in Russia, Ukraine, and Pakistan 506680-001

Intel WiFi Link 5300 802.11a/b/g/n for iAMT WLAN module for use in all countries and regions 506679-001

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the memory module/WLAN module compartment cover (see Memory module
on page 49).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal. If the computer is
equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable is connected to
the middle terminal on the WLAN module.

2. Remove the two Phillips PM2.0×4.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion into the WLAN
module slot.

Reverse this procedure to install the WLAN module.
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Optical drive

Description Spare part number

DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe 493990-001

Blu-ray ROM DVD+/-RW SuperMulti DL Drive 493989-001

DVD-ROM Drive 493988-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the optical drive:

1. Position the computer with the left side toward you.

2. Loosen the captive Phillips PM2.5×9.0 screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the right to release the optical drive from the computer.

4. Remove the optical drive (3).

5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.

6. Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the optical
drive.
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7. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install an optical drive.
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Keyboard

NOTE: The keyboard spare part kit includes a keyboard cable.

For use in: Spare part number For use in: Spare part number

Belgium

Brazil

The Czech Republic

Denmark

France

French Canada

Germany

Greece

Hungary

Iceland

Israel

Italy

Japan

Latin America

The Netherlands and Europe

494002-A41

494002-201

494002-221

494002-081

494002-051

494002-121

494002-041

494002-151

494002-211

494002-DD1

494002-BB1

494002-061

494002-291

494002-161

494002-021

Norway

Portugal

Russia

Saudi Arabia

Slovakia

Slovenia

South Korea

Spain

Sweden and Finland

Switzerland

Taiwan

Thailand

Turkey

The United Kingdom

The United States

494002-091

494002-131

494002-251

494002-171

494002-231

494002-BA1

494002-AD1

494002-071

494002-B71

494002-111

494002-AB1

494002-281

494002-141

494002-031

494002-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the keyboard:

1. Position the computer upside down with the front toward you.
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2. Loosen the four Phillips PM2.5×9.0 captive screws that secure the keyboard to the computer.

3. Turn the computer right-side up, with the front toward you.

4. Lift the upper right corner of the keyboard (1) and swing the rear of the keyboard up (2).

5. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.
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6. Release the ZIF connector (3) to which the pointing stick cable is attached, and disconnect the
pointing stick cable (4) from the system board.

7. Remove the keyboard.

Reverse this procedure to install the keyboard.
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RTC battery

NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all
passwords and CMOS settings to be cleared.

Description Spare part number

RTC battery 449137-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the keyboard (see Keyboard on page 55).

Remove the RTC battery:

1. Press the clip on the right side of the battery socket (1) toward the right until the battery disengages
from beneath the clip.

2. Remove the RTC battery (2) from the system board.

Reverse this procedure to install the RTC battery.
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Switch cover

Description Spare part number

Switch cover (includes LED board and cable and power button board) 493986-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the keyboard (see Keyboard on page 55).

Remove the switch cover:

1. Turn the computer upside down, with the rear panel toward you.

2. Remove the three PM2.0×3.0 broadhead screws that secure the switch cover to the computer.

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as possible.

5. Lift the left and right sides of the switch cover to release it from the computer (1).

6. Release the ZIF connector to which the LED board cable is connected (2) and disconnect the cable
from the system board.
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7. Remove the switch cover (3) by lifting it straight up.

Reverse this procedure to install the switch cover.
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Fan

Description Spare part number

Fan 494000-001

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the keyboard (see Keyboard on page 55).

6. Remove the switch cover (see Switch cover on page 59).

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Remove the three PM2.0×3.0 screws (2) that secure the fan to the computer.

3. Lift the fan from the computer (3).

Reverse this procedure to install the fan.

Graphics card heat sink

NOTE: The spare part kit for the graphics card heat sink includes replacement thermal material.
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Description Spare part number

Graphics card heat sink for use in computer models with nVidia Quadro FX 2700M graphics cards 494011-001

Graphics card heat sink for use in computer models with ATI graphics cards 494211-001

Graphics card heat sink for use in computer models with nVidia Quadro FX 3700M graphics cards 518096-001

Before removing the graphics card heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 41).

b. Keyboard (see Keyboard on page 55)

c. Switch cover (see Switch cover on page 59)

d. Fan (see Fan on page 61)

Remove the graphics card heat sink:

1. Loosen the two black captive PM3.0×10.0 screws and four silver captive PM3.0×10.0 screws in
the order shown in the following illustration. You may have to move the inverter cable to access
the screw identified by callout (2).

NOTE: The heat sink may look different from the illustrations in this section, depending upon the
model.
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2. Lift the heat sink up slightly and toward the front of the computer (1) to disengage it from the system
board, and then lift the heat sink from the computer (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the graphics card heat
sink and the graphics card each time the graphics card heat sink is removed.

Reverse this procedure to install the graphics card heat sink.
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Graphics card

NOTE: The spare parts kit for the graphics card includes replacement thermal material.

Description Spare part number

ATI Mobility FireGL V5725 493982-001

nVidia Quadro FX 2700M 493983-001

nVidia Quadro FX 3700M 493984-001

Before removing the graphics card, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 41)

b. Keyboard (see Keyboard on page 55)

c. Switch cover (see Switch cover on page 59)

d. Fan (see Fan on page 61)

e. Graphics card heat sink (Graphics card heat sink on page 61)

Remove the graphics card:

1. Remove the two PM2.5×4.0 screws (1) that secure the graphics card to the system board.

2. Lift the front edge of the graphics card (2) until it clears the adjacent edge of the top cover.
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3. Remove the graphics card by sliding it away from the graphics card slot at an angle (3).

NOTE: The graphics card is designed with a notch  to prevent incorrect installation.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the graphics card
and graphics card heat sink each time the graphics card heat sink is removed.

Reverse this procedure to install the graphics card.
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Processor heat sink

NOTE: The processor heat sink spare part kit includes replacement thermal material.

Description Spare part number

For use only with computer models equipped with the following processors: P8400, P8600, T9400,
and T9600

494010-001

For use only with computer models equipped with the following processors: X9100, Q9100, and
QX9300

494210-001

Before removing the processor heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 41)

b. Keyboard (see Keyboard on page 55)

c. Switch cover (see Switch cover on page 59)

d. Fan (see Fan on page 61)

e. Graphics card heat sink (Graphics card heat sink on page 61)

Remove the processor heat sink:

1. In the order indicated on the heat sink, loosen the four Phillips PM2.0×8.0 captive screws (1) that
secure the processor heat sink to the base enclosure.

2. Lift the right side of the processor heat sink (2) until it disengages from the processor.
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3. Release the processor heat sink by sliding it to the right until it clears the base enclosure, and then
lift the heat sink up and out of the computer (3).

Reverse this procedure to install the processor heat sink.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the processor heat sink
and the processor each time the processor heat sink is removed.
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Processor

NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

Intel Core2 Extreme QX9300 2.53-GHz processor (12-MB L2 cache, 1066-MHz FSB) 507946-001

Intel Core2 Extreme X9100 3.06-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507950-001

Intel Core2 Quad Q9100 2.26-GHz processor (12-MB L2 cache, 1066-MHz FSB) 507947-001

Intel Core2 Quad Q9000 2.0-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507948-001

Intel Core2 Duo T9900 3.06-GHz processor (6-MB L2 cache, 1066-MHz FSB) 570434-001

Intel Core2 Duo T9800 2.93-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507951-001

Intel Core2 Duo T9550 2.66-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507953-001

Intel Core2 Duo T9600 2.80-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507955-002

Intel Core2 Duo T9400 2.53-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507956-002

Intel Core2 Duo MV P8600 2.40-GHz processor (3-MB L2 cache, 1066-MHz FSB) 507963-002

Intel Core2 Duo MV P8400 2.26-GHz processor (3-MB L2 cache, 1066-MHz FSB) 506964-002

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 41)

b. Keyboard (see Keyboard on page 55)

c. Switch cover (see Switch cover on page 59)

d. Fan (see Fan on page 61)

e. Graphics card heat sink (Graphics card heat sink on page 61)

f. Processor heat sink (see Processor heat sink on page 66)

Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.
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2. Lift the processor (2) straight up and remove it.

NOTE: The gold triangle (3) on the processor must be aligned with the triangle (4) embossed on
the processor socket when you install the processor.

Reverse this procedure to install the processor.
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Display assembly

NOTE: All display assembly spare part kits include 3 WLAN antenna transceivers and cables.

Description Spare part number

17.0-inch, WUXGA+ WVA AntiGlare display assembly without camera module 494016-001

17.0-inch, WUXGA+ WVA AntiGlare display assembly with camera module 494017-001

17.0-inch, WSXGA+ WVA AntiGlare display assembly without camera module 494012-001

17.0-inch, WSXGA+ WVA AntiGlare display assembly with camera module 494013-001

17.0-inch, WUXGA DreamColor display assembly without camera module 494014-001

17.0-inch, WUXGA DreamColor display assembly with camera module 494015-001

17.0-inch, WXGA+ AntiGlare display assembly without camera module 494018-001

17.0-inch, WXGA+ AntiGlare display assembly with camera module 494019-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the keyboard (see Keyboard on page 55).

6. Remove the switch cover (see Switch cover on page 59).

Remove the display assembly:

1. Turn the computer upside down, with the rear panel toward you.

2. Remove the four Torx T8M2.5×9.0 screws (1) from the rear panel that secure the display assembly
to the computer.

3. Remove the Torx T8M2.5×9.0 screw (2) from the left rear corner of the computer.
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4. Remove the PM2.5×4.0 screw (3) from the battery bay.

5. Turn the computer right-side up, with the front toward you and open as far as possible.

6. Disconnect the display panel cable (1) from the system board. The display panel cable is available
using spare part number 495607-001 for DreamColor LED models, 494005-001 for LCD models.

7. Disconnect the microphone cable (2) from the system board.

8. Remove the wireless antenna cables from the clips (1) and routing channels built into the top cover.
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9. Disconnect the camera cable (2) from the system board.

CAUTION: The display assembly will be unsupported when the following screws are removed.
To prevent damage to the display assembly, support it before removing the screws.

10. Remove the PM2.5×4.0 screw (1) from the left display hinge.

11. Remove the Torx T8M2.5×9.0 screw (2) from the right hinge.

12. Lift the display assembly (3) straight up and remove it.
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13. If it is necessary to replace the display bezel or display hinges, remove the six screw covers (1)
and six Torx T8M2.5×6.0 screws (2) that secure the display bezel to the display enclosure. The
display bezel is available using spare part number 494003-001 for models without a camera
module, 495030-001 for models with a camera module.

NOTE: See Display inverter or ambient light sensor on page 42 for display inverter replacement
instructions.

14. Flex the display bezel bottom edge (1), the inside edges of the left and right sides (2), and then the
display bezel top edge (3) until the bezel disengages from the display assembly.

NOTE: There are two posts that protrude through two holes on the top edge of the bezel. So that
you do not break the posts, be sure to lift the bezel straight up when removing it from the display
assembly (4).

15. If it is necessary to remove the display panel, remove the two Torx T8M2.5×6.0 screws (1) that
secure the display panel to the display enclosure.
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16. Remove the display panel from the display enclosure by lifting it straight up (2). The display
enclosure is available using spare part number 495895-001 for DreamColor LED models,
494005-001 for LCD models.

17. If it is necessary to replace the display hinges, remove the four Phillips PM2.0×4.0 screws (1) that
secure each display hinge to the display panel.

18. Remove the display hinges (2). The left and right display hinges are included in the Display Bracket
Kit, spare part number 494004-001.
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19. If it is necessary to replace the display cable, disconnect the cable from the connector (1), and then
remove the cable from the display enclosure (2). The display cable is available using spare part
number 494005-001 for LCD displays, 495607-001 for DreamColor LED displays.

Reverse this procedure to reassemble and install the display assembly.
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Camera module

Description Spare part number

Camera module (includes flex cable) 494030-001

Before removing the camera module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 41)

b. Keyboard (see Keyboard on page 55)

c. Switch cover (see Switch cover on page 59)

d. Display (see Display assembly on page 70)

Remove the camera module:

1. Loosen the tape (1) that secures the camera cable to the display enclosure.

2. Disconnect the camera flex cable from the camera board (2).

3. Use a flat-bladed screwdriver to loosen the camera module from the clips in the display enclosure,
and then pull the module and cable through the opening near the top of the enclosure (3).
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4. Use a flat-blade screwdriver to loosen tape that secures the camera module board to the display
enclosure, and then remove the board.

Reverse this procedure to install the camera module.
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Top cover

NOTE: The top cover spare part kit includes a fingerprint reader board and cable.

Description Spare part number

Top cover (includes TouchPad, TouchPad bracket, TouchPad cable, fingerprint reader board and
cable)

493987-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 41)

b. Keyboard (see Keyboard on page 55)

c. Switch cover (see Switch cover on page 59)

d. Display assembly (see Display assembly on page 70)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the three large (1) and five small (2) rubber screw covers.

78 Chapter 4   Removal and replacement procedures



3. Remove the 12 Torx T8M2.5×9.0 screws (1) and two PM2.5×4.0 screws (2) that secure the top
cover to the base enclosure.

4. Turn the computer right-side up, with the front toward you.

5. Disconnect the TouchPad board cable (1) and the fingerprint reader board cable (2) from the
system board.
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6. Remove the one Torx T8M2.5×9.0 screw (1) and the three PM2.5×4.0 screws (2) that secure the
top cover to the computer.

7. Lift the front edge of the top cover (1) until it rests at an angle.

8. Lift the left and right edges of the top cover outward and then up (2) up until it disengages from the
base enclosure.

9. Remove the top cover (3).

Reverse this procedure to install the top cover.
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Media card reader/audio board

Description Spare part number

Media card reader/audio board 493978-001

Before removing the media card reader/audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 41).

b. Keyboard (see Keyboard on page 55)

c. Switch cover (see Switch cover on page 59)

d. Display assembly (see Display assembly on page 70)

e. Top cover (see Top cover on page 78)

Remove the media card reader/audio board:

1. Remove the three PM2.5×4.0 screws that secure the board to the system board (1).

2. Lift the back of the board up, and then lift it from the system board (2).

Reverse this procedure to install the media card reader/audio board.
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USB/eSATA board

Description Spare part number

USB/eSATA board (includes cable) 493981-001

Before removing the USB/eSATA board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 41)

b. Optical drive (see Optical drive on page 53)

c. Keyboard (see Keyboard on page 55)

d. Switch cover (see Switch cover on page 59)

e. Display assembly (see Display assembly on page 70)

f. Top cover (see Top cover on page 78)

Remove the USB/eSATA board:

1. Disconnect the USB/eSATA board cable (1) from the system board.

2. Remove the two PM2.5×4.0 screws (2) that secure the USB/eSATA board to the base enclosure.

3. Lift the left side of the USB/audio board (3) until the USB and eSATA connectors disengage from
the openings in the base enclosure.

4. Remove the USB/eSATA board and cable from the base enclosure.
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Reverse this procedure to install the USB/eSATA board.

Speaker assembly

Description Spare part number

Speaker assembly 494029-001

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 41)

b. Keyboard (see Keyboard on page 55)

c. Switch cover (see Switch cover on page 59)

d. Display assembly (see Display assembly on page 70)

e. Top cover (see Top cover on page 78)

Remove the speaker assembly:

1. Remove the two PM2.5×4.0 screws (1) that secure the speaker to the base enclosure.

2. Disconnect the speaker cable (2) from the system board.

3. Remove the speaker assembly (3) from the base enclosure.
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Reverse this procedure to install the speaker assembly.

Modem module

Description Spare part number

Modem module for use in all countries and regions except for Australia and New Zealand 461750-001

Modem module for use only in Australia and New Zealand 461750-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 41)

b. Keyboard (see Keyboard on page 55)

c. Switch cover (see Switch cover on page 59)

d. Display assembly (see Display assembly on page 70)

e. Top cover (see Top cover on page 78)

f. Speaker assembly (see Speaker assembly on page 83)

Remove the modem module:

1. Remove the two Phillips PM2.0×4.0 screws (1) that secure the modem module to the system board.

2. Disconnect the modem module (2) from the system board by lifting it straight up.
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3. Disconnect the modem module cable (3) from the modem module.

4. Remove the modem module.

Reverse this procedure to install the modem module.

System board

NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

System board for use in computer models with dual core processors (includes RTC battery) 493980-001

System board for use in computer models with quad core processors (includes RTC battery) 501508-001

System board for use only in computer models with Core2 Duo processors in the People's Republic
of China and Russia (includes RTC battery)

509762-001

System board for use only in computer models with Core2 Quad processors in the People's Republic
of China and Russia (includes RTC battery)

509763-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 41)

b. Hard drive (see Hard drive on page 45)

c. Bluetooth module (see Bluetooth module on page 48)

d. Optical drive (see Optical drive on page 53)
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e. Keyboard (see Keyboard on page 55)

f. Switch cover (see Switch cover on page 59)

g. Fan (see Fan on page 61)

h. Graphics card heat sink (see Graphics card heat sink on page 61)

i. Graphics card (see Graphics card on page 64)

j. Processor heat sink (see Processor heat sink on page 66)

k. Display assembly (see Display assembly on page 70)

l. Top cover (see Top cover on page 78)

m. Speaker assembly (see Speaker assembly on page 83)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● Memory modules (see Memory module on page 49)

● WLAN module (see WLAN module on page 51)

● Modem module (see Modem module on page 84)

● Processor (see Processor on page 68)

● ExpressCard assembly (see ExpressCard assembly on page 88)

Remove the system board:

1. Turn the computer right-side up, with the front toward you.

2. Remove the three PM2.5×4.0 screws that secure the system board to the base enclosure.
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3. Disconnect the modem cable from the system board:

4. Disconnect the microphone cable from the system board.

5. Disconnect the RJ-11 cable from the system board and remove the jack from the base enclosure.

6. Use the optical drive connector (1) to lift the right side of the system board (2) until it rests at an
angle.
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7. Remove the system board (3) by sliding it away from the base enclosure at an angle.

Reverse this procedure to install the system board.

ExpressCard assembly

Description Spare part number

ExpressCard assembly 493999-001

Before removing the ExpressCard assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 41)

b. Hard drive (see Hard drive on page 45)

c. Bluetooth module (see Bluetooth module on page 48)

d. Optical drive (see Optical drive on page 53)

e. Keyboard (see Keyboard on page 55)

f. Switch cover (see Switch cover on page 59)

g. Fan (see Fan on page 61)

h. Graphics card heat sink (see Graphics card heat sink on page 61)

i. Graphics card (see Graphics card on page 64)
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j. Processor heat sink (see Processor heat sink on page 66)

k. Display assembly (see Display assembly on page 70)

l. Top cover (see Top cover on page 78)

m. Speaker assembly (see Speaker assembly on page 83)

n. System board (see System board on page 85)

Remove the ExpressCard assembly:

1. Turn the system board upside down, with the ExpressCard eject button toward you.

2. Lift the Mylar covering up (1) to expose the screws that secure the assembly to the system board.

3. Remove the two Phillips PM2.0×6.0 screws (2) that secure the ExpressCard assembly to the
system board.

4. Turn the system board right-side up.

5. Remove the two Phillips PM2.0×7.0 screws (1) that secure the ExpressCard assembly to the
system board.
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6. Remove the ExpressCard assembly from the system board (2).

Reverse this procedure to install the ExpressCard assembly.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the keyboard arrow keys and then press enter, or use
a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Ignore changes and exit, and then press enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password) ● Create a new BIOS user account.

● View a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

Allow Reset of HP ProtectTools security keys Enable/disable reset of HP ProtectTools security keys.

Change Password Enter, change, or delete a BIOS administrator password.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software Help.

NOTE: You must have a setup password to change this
setting.

Automatic DriveLock Enable/disable Automatic DriveLock support.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the selected
drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.

Setup BIOS Administrator Password Set up a BIOS administrator password.

Always Prompt for HP SpareKey Enrollment Enable/disable a prompt for HP SpareKey enrollment.
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Diagnostics menu

Select To do this

System Diagnostics menu ● F1 System Information—Displays the following
information:

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

● F2 Start-up Test—Verifies the system components
needed for starting the computer.

● F3 Run-In Test—Runs a comprehensive check on
system memory.

● F4 Hard Disk Test—Runs a comprehensive self-test on
any hard drive in the system.

● F5 Error Log—Displays a log file if any errors have
occurred.
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System Configuration menu

NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (enabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (enabled by
default).

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device Configurations ● Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running.

◦ Startup from bootable USB devices, including a hard
drive, diskette drive, or optical drive connected by a
USB port to the computer.

● Select a parallel port mode: ECP (Enhanced Capabilities
Port), standard, bidirectional, or EPP (Enhanced Parallel
Port).

● Enable/disable fan always on while connected to an AC
outlet (enabled by default).

● Enable/disable LAN Power Save (select models only).
When enabled, saves power by turning off the LAN when
not in use (enabled by default).

● Enable/disable Data Execution Prevention. When
enabled, the processor can disable some virus code
execution, which helps to improve computer security.

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (select models only)

96 Chapter 5   Computer Setup



Select To do this

NOTE: Availability of the options above varies by
computer model.

● Enable/disable secondary battery fast charge (enabled by
default).

● Enable/disable HP QuickLook 2 (enabled by default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable TXT (Intel Trusted Execution Technology)
(select models only; disabled by default).

● Enable/disable Dual Core CPU (select models only;
enabled by default).

● Enable/Disable Unified Extensible Firmware Interface
(UEFI) mode (disabled by default).

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WWAN device radio (select
models only; enabled by default).

● Enable/disable embedded Bluetooth device radio
(enabled by default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network (set by default)

◦ Follow Boot Order

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the embedded WLAN device (enabled by
default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Enable the ambient light sensor (enabled by default).

● Enable/disable the Notebook Multibay device (enabled by
default).

● Enable/disable the integrated camera (select models
only; enabled by default).
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Select To do this

Port Options (all are enabled by default) NOTE: All port options are enabled by default.

● Enable/disable the Smart Card slot.

● Enable/disable the ExpressCard slot.

● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

AMT Options NOTE: All AMT options are disabled by default.

● Enable/disable Firmware Verbosity.

● Enable/disable AMT Setup Prompt (CTRL-P).

● Enable/disable USB Key Provisioning Support.

● Enable/disable Unconfigure AMT on Next Boot.

● Enable/disable Terminal Emulation Mode

● Enable/disable Firmware Progress Event Support.

● Enable/disable include TYPE-131 in SMBIOS.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.

98 Chapter 5   Computer Setup



6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Length 28.2 cm 11.1 in

Width 39.3 cm 15.5 in

Height (front to rear) 3.2 cm 1.3 in

Weight (equipped with 8-cell battery, 80-GB/5400-rpm hard
drive, optical drive, one 1024-MB memory module, WLAN
module, pointing stick, TouchPad, and nVidia GM84 graphics
card; varies by configuration)

3.5 kg 7.6 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 120 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate
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Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

17.0-inch, WUXGA+WVA display specifications

 Metric U.S.

Dimensions

Height 24.4 cm 9.65 in

Width 38.1 cm 15.0 in

Diagonal 43.2 cm 17.0 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.172 × 0.172 mm

Format 1920 × 1200

Configuration RGB vertical stripe

Backlight CCFT

Character display 80 × 25

Total power consumption 6.0 W

Viewing angle +/-65° horizontal, +/-50° vertical (typical)
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17.0-inch, WSXGA+WVA display specifications

 Metric U.S.

Dimensions

Height 24.4 cm 9.6 in

Width 38.1 cm 15.0 in

Diagonal 43.2 cm 17.0 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.172 × 0.172 mm

Format 1680 × 1050

Configuration RGB vertical stripe

Backlight CCFT

Character display 80 × 25

Total power consumption 7.0 W

Viewing angle +/-60° horizontal, +40/-50° vertical (typical)
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17.0-inch, WXGA+WVA display specifications

 Metric U.S.

Dimensions

Height 24.4 cm 9.6 in

Width 38.1 cm 15.0 in

Diagonal 43.2 cm 17.0 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.259 × 0.259 mm

Format 1440× 900

Configuration RGB vertical stripe

Backlight CCFT

Character display 80 × 25

Total power consumption 6.5 W

Viewing angle +/-45° horizontal, +15/-35° vertical (typical)
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Hard drive specifications

 250-GB* 250-GB* 160-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g

Interface type SATA SATA SATA

Transfer rate 300 MB/sec 300 MB/sec 150 MB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.1 ms 1.1 ms 1.5 ms

Average 12 ms 12 ms 0.5 ms

Maximum 20 ms 20 ms 20.5 ms

Logical blocks 625,142,448 488,397,168 312,581,808

Disk rotational speed 7200 rpm 7200 and 5400 rpm 7200 and 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Blu-ray ROM DVD+/-RW SuperMulti DL Drive
specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-
TEXT, CD-ROM, CD-ROM XA,
MIXED MODE CD, CD-I, CD-I Bridge
(Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio,
CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, BD-ROM, BD-
RE. BD-R

Write:

CD-R and CD-RW

DVD+R, DVD+R(9), DVD+RW, DVD-R,
DVD-R(9),DVD-RW, DVD-RAM

Access time CD DVD Blu-ray

Random 150 ms 180 ms 300 ms

Cache buffer 8 MB  

Data transfer rate    

24X CD-ROM 3,600 KB/sec  

8X DVD-ROM 10,800 KB/sec  

24X CD-R 3,600 KB/sec  

16X CD-RW 2,400 KB/sec  

8X DVD+R 10,800 KB/sec  

4X DVD+RW 5,400 KB/sec  

8X DVD-R 10,800 KB/sec  

4X DVD-RW 5,400 KB/sec  

2.4X DVD+R(9) 2,700 KB/sec  

5X DVD-RAM 6,750 KB/sec  

1X BD-ROM 4,500 KB/sec  

1X BD-R read 4,500 KB/sec  

1X BD-RE read 4,500 KB/sec  

Transfer mode Multiword DMA Mode  
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DVD±RW and CD-RW Combo Drive, Double-Layer with
LightScribe specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-
RW, DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode
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DVD-ROM Drive

Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital
Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Access time CD DVD

Random < 100 ms < 125 ms

Cache buffer 512 KB

Data transfer rate  

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2 16.6 MB/s
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System DMA specifications

Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for ExpressCard

DMA6 Not assigned

DMA7 Not assigned

*ExpressCard controller can use DMA 1, 2, or 5.

System memory map specifications

Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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System interrupt specifications

Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: ExpressCards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial
port may assert IRQ3 or IRQ4.
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System I/O address specifications

I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)

202 - 21F Unused
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I/O address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 ExpressCard controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in
the computer. All screws listed in this section are available in the Screw Kit, spare part number
494028-001.

Phillips PM3.0×4.0 screw

Color Quantity Length Thread Head diameter

Black 4 4.0 mm 3.0 mm 5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive
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Phillips PM2.5×9.0 captive screw

Color Quantity Length Thread Head diameter

Black 5 9.0 mm 2.5 mm 5.0 mm

Where used: (1) One captive screw that secures the optical drive to the computer (screw is secured by
a C-clip)

Where used: (2) Four captive screws that secure the keyboard to the computer (screws are secured
by C-clips)
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Phillips PM2.0×6.0 screw

Color Quantity Length Thread Head diameter

Silver 2 6.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the ExpressCard to the system board

Phillips PM2.0×6.0 screw 113



Phillips PM2.0×7.0 screw

Color Quantity Length Thread Head diameter

Silver 2 7.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the ExpressCard assembly to the base enclosure
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Phillips PM2.5×4.0 screw

Color Quantity Length Thread Head diameter

Black 20 4.0 mm 2.5 mm 5.0 mm

Where used: 3 screws that secure the system board to the base enclosure

Where used: 2 screws that secure the modem module to the system board
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Where used: 3 screws that secure the top cover to the base enclosure

Where used: 2 screws that secure the speaker assembly to the base enclosure

Where used: 2 screws that secure the top cover to the system board
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Where used: 2 screws that secure the WLAN module to the computer

Where used: 2 screws that secure the graphics card to the system board

Where used: One screw in the battery bay that secures the display to the base enclosure

Phillips PM2.5×4.0 screw 117



Where used: One screw near the left hinge that secures the display to the base enclosure

Where used: 2 screws that secure the USB/eSATA module to the base enclosure
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Torx T8M2.5×6.0 screw

Color Quantity Length Thread Head diameter

Black 9 6.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the inverter to the display enclosure

Where used: 6 screws that secure the display bezel to the display enclosure
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Where used: 2 screws that secure the display panel to the display enclosure
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Phillips PM2.0×5.0 captive screw

Color Quantity Length Thread Head diameter

Black 3 5.0 mm 2.0 mm 5.0 mm

Where used:

(1) 2 captive screws that secure the hard drive compartment cover to the computer (screws are secured
by C-clips)

(2) One captive screw that secures the memory module/WLAN module compartment cover to the
computer (screw is secured by a C-clip)
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Phillips PM2.5×11.0 captive screw

Color Quantity Length Thread Head diameter

Black 1 11.0 mm 2.5 mm 5.0 mm

Where used: 1 captive screw that secures the hard drive to the computer
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Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Silver 13 3.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the optical drive bracket to the optical drive

Where used: 3 screws that secure the fan to the base enclosure
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Where used: 8 screws that secure the display brackets to the display

Phillips PM3.0×10.0 captive screw

Color Quantity Length Thread Head diameter

Black 2 10.0 mm 3.0 mm 5.0 mm

Where used: 2 captive screws that secure the graphics card heat sink to the computer (screws are
secured by C-clips)
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Color Quantity Length Thread Head diameter

Silver 4 10.0 mm 3.0 mm 5.0 mm

Where used: 4 captive screws that secure the graphics card heat sink to the computer
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Torx TM2.5×9.0 screw

Color Quantity Length Thread Head diameter

Black 18 9.0 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the heat sink to the computer

Where used: One screw that secures the top cover to the computer
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Where used: 12 screws that secure the top cover to the base enclosure

Where used: One screw that secures the top cover to the base enclosure
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Black Phillips PM2.0×3.0 broad head screw

Color Quantity Length Thread Head diameter

Black 3 2.0 mm 3.0 mm 7.0 mm

Where used: 3 screws that secure the switch cover to the computer
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8 Backup and recovery

Backup and recovery in Windows Vista

Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

● Backing up individual files and folders

● Backing up the entire hard drive (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents folder, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on
the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the computer.

To create a backup using Backup and Restore Center, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use the Backup and Restore Center to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)” section
in this guide.

130 Chapter 8   Backup and recovery



Using the Windows recovery tools

To recover information you previously backed up, follow these steps:

1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To find
the partitions, select Start > Computer.

NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD and
the Driver Recovery disc (both purchased separately). For additional information, refer to the “Using
a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a search
for these topics in Help and Support.

Using f11

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The f11 recovery
tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows Vista operating
system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
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4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system
DVD to reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows Vista operating system
DVD, go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

Backup and recovery in Windows XP

Overview

To protect your information, use the Windows Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore your
computer.

Windows provides the following options:

● Backing up individual files and folders

● Backing up all files and folders

● Scheduling automatic backups

● Creating recovery points

● Recovering information

NOTE: For detailed instructions, perform a search for these topics in Help and Support.
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NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

● Store personal files in the My Documents folder, and back it up periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, click Edit > Paste.

The screen image is added to the document.

4. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

● Operating System and Driver Recovery discs (included with your computer): You can use the discs
to recover your operating system and programs installed at the factory.
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Recovering your information

To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Click Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs

CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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9 Connector pin assignments

1394

Pin Signal

1 Twisted pair B-

2 Twisted pair B+

3 Twisted pair A-

4 Twisted pair A+

1394 135



Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog
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Pin Signal

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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HDMI

Pin Signal

1 TMDS data 2+

2 TMDS data 2 shield

3 TMDS data 2–

4 TMDS data 1+

5 TMDS data 1 shield

6 TMDS data 1–

7 TMDS data 0+

8 TMDS data 0 shield

9 TMDS data 0–

10 TMDS clock+

11 TMDS clock shield

12 TMDS clock–

13 CEC

14 Not connected

15 DDC clock

16 DDC data

17 Ground

18 +5V power

19 Hot plug detect

20 Shell
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the display inverter
(2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Symbols/Numerics
1394 port

pin assignments 135
1394 port, identifying 14

A
AC adapter, spare part

numbers 27
accessory battery connector,

identifying 16
ambient light sensor

removal 42
spare part number 42

ambient light sensor board
spare part number 24,  31

ambient light sensor, identifying 6
AMT options 98
AMT options, AMT setup prompt

(CTRL-P) 98
AMT options, firmware progress

event supporty 98
AMT options, firmware

verbosity 98
AMT options, terminal emulation

mode 98
AMT options, TYPE-131 in

SMBIOS 98
AMT options, unconfigure AMT on

next boot 98
AMT options, USB key provisioning

support 98
antennae

disconnecting 51
applications key, Windows 12
audio board

spare part numbers 81
audio, product description 3
audio-in (microphone) jack,

identifying 13

audio-in jack
pin assignments 136

audio-out (headphone) jack,
identifying 13

audio-out jack
pin assignments 136

B
backing up 129,  133
base enclosure, spare part

number 23,  29
battery

removal 41
spare part number 23,  29,

41
battery bay 16
battery light, identifying 9,  13
battery release latch,

identifying 16
bays

battery 16
hard drive 16

bezel
illustrated 24
spare part number 24

BIOS Administrator password 94
Blu-ray ROM DVD+/-RW

SuperMulti DL Drive
removal 53
spare part number 22,  27,

29,  53
specifications 104

Bluetooth cable, illustrated 26
Bluetooth compartment cover,

illustrated 25
Bluetooth module

removal 48
spare part number 21,  28,

48
boot options 96

boot order 96
built-in device

ambient light sensor 97
Bluetooth device radio 97
embedded WLAN 97
fingerprint reader 97
integrated camera 97
LAN/WLAN switching 97
modem 97
Network Interface Controller

(LAN) 97
Wake on LAN 97
wireless button 97
WWAN device radio 97

built-in device options 97
built-in-device

Notebook Multibay 97
business card slot, identifying 14
buttons

display release 14
info 10
pointing stick 7
power 10
presentation 11
TouchPad 7
volume mute 11
wireless 11

C
Cable Kit

contents 26
spare part number 23,  26,

29
cable kit, spare part number 25
cables, service considerations 34
camera module

removal 76
spare part numbers 76

camera module, spare part
number 31
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caps lock light, identifying 8
chipset, product description 1
CMOS clearing 38
compartments

memory module 16
components

bottom 16
display 6
front 13
left-side 14
rear 15
right-side 15
top 7
wireless antennae 17

computer feet
locations 40
spare part number 23,  31,

40
Computer Setup

accessing 91
Diagnostics menu 95
File menu 93
navigating and selecting 91
restoring factory settings 92
Security menu 94
System Configuration

menu 96
using 91

computer specifications 99
connector, power 14
connectors

service considerations 34

D
device configurations 96
Diagnostics menu 95
discs

Driver Recovery 133
Operating System 133,  134

Disk Sanitizer 94
diskette drive

precautions 34
product description 3

display assembly
removal 70
spare part numbers 20,  31,

70
display bezel

illustrated 24
release 42

removal 73
spare part number 24

display bezel, spare part
number 30

Display Bracket Kit, spare part
number 31

display cable, spare part
number 24

display component recycling 143
display components

illustrated 24
spare part numbers 24

display enclosure
illustrated 24
spare part number 25

display hinge
removal 74
spare part number 31,  74

Display Hinge Kit, spare part
number 25

display inverter
illustrated 24
removal 42
spare part number 24,  30,

42
display panel

illustrated 24
product description 1
removal 74

display release button,
identifying 14

display specifications 100,  101,
102

docking connector, identifying 16
docking support, product

description 4
drive light, identifying 9,  13
DriveLock password 94
DriveLock, automatic 94
Driver Recovery disc 133
drives

preventing damage 34
drives, boot order 96
Dual Core CPU 97
DVD-ROM Drive

precautions 34
removal 53
spare part number 22,  27,

29

spare part numbers 53
specifications 106

DVD-RW Drive
precautions 34
specifications 105

DVD/CD-RW Combo Drive
precautions 34

DVD±RW and CD-RW Combo
Drive

precautions 34
spare part numbers 22,  27,

29
specifications 105

DVD±RW and CD-RW SuperMulti
Double-Layer Combo Drive with
LightScribe

removal 53
spare part numbers 53

E
electrostatic discharge 35
eSata port, identifying 15
esc key, identifying 12
Ethernet, product description 3
Execution Disable 96
ExpressCard assembly

removal 88
spare part number 22,  30,

88
ExpressCard slot bezel,

illustrated 25
ExpressCard slot, identifying 14
external media cards, product

description 3
external monitor port

pin assignments 136
external monitor port,

identifying 14

F
f11 recovery 131
fan

removal 61
spare part number 30,  61

fan, spare part number 21
feet

locations 40
spare part number 23,  31,

40
File menu 93
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fingerprint reader, identifying 11
fn key, identifying 12
function keys, identifying 12

G
graphics card

removal 64
spare part numbers 21,  29,

64
Graphics card heat sink

spare part number 21
graphics card heat sink

removal 61
spare part numbers 61

Graphics card heat sink – ATI,
spare part number 31

Graphics card heat sink – nVidia,
spare part number 31

graphics, product description 1
grounding equipment and

methods 37

H
hard disk test 95
hard drive

precautions 34
product description 2
removal 45
spare part numbers 21,  27,

29,  45
specifications 103

hard drive bay, identifying 16
hard drive bracket, removal 47
hard drive compartment cover

illustrated 25
hard drive cover

removal 46
hard drive recovery 131
HDMI port

pin assignments 138
headphone (audio-out) jack 13
headphone jack

pin assignments 136
heat sink

spare part numbers 21,  31
hinge

removal 74
spare part number 31,  74

HP QuickLook 2 97
HP SpareKey enrollment 94

I
I/O address specifications 109
IEEE 1394 port, identifying 14
info button, identifying 10
internal display switch,

identifying 6,  10
internal microphone, identifying 6
interrupt specifications 108
inverter

illustrated 24
removal 42
spare part number 24,  42

J
jacks

audio-in (microphone) 13
audio-out (headphone) 13
RJ-11 (modem) 15
RJ-45 (network 15

K
keyboard

product description 4
removal 55
spare part numbers 20,  30,

55
keypad keys, identifying 12
keys

esc 12
fn 12
function 12
keypad 12
Windows applications 12
Windows logo 12

L
LAN Power Save 96
language, changing in Computer

Setup 96
latch, battery release 16
legacy support, USB 96
lights

battery 9,  13
caps lock 8
drive 9,  13
mute 8
num lock 8
power 8,  13
volume down 8
volume mute 8
volume up 8

webcam 6
wireless 8,  13

M
mass storage devices, spare part

numbers 27
Media Card Reader,

identifying 14
media card reader/audio board

removal 81
Media card reader/audio board,

spare part number 22
media card reader/audio board,

spare part number 29
memory map specifications 107
memory module

product description 2
removal 49
spare part numbers 22,  31,

49
memory module compartment,

identifying 16
memory module/WLAN module

compartment cover
illustrated 25
removal 49

microphone (audio-in) jack 13
microphone extension cable

illustrated 26
microphone jack

pin assignments 136
microphone, product

description 3
model name 1
modem jack

pin assignments 139
modem module

product description 3
removal 84
spare part number 21,  28,

84
monitor port

pin assignments 136
monitor port, external 14
mute button, identifying 11
mute light, identifying 8

N
network jack

pin assignments 139
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num lock light, identifying 8

O
Operating System disc 133,  134
operating system, product

description 4
optical drive

precautions 34
product description 2
removal 53
spare part numbers 22,  27,

29,  53
specifications 104,  105,  106

P
packing guidelines 36
parallel port mode 96
password clearing 38
passwords 94
pin assignments

1394 port 135
audio-in jack 136
audio-out jack 136
external monitor port 136
HDMI port 138
headphone jack 136
microphone jack 136
modem jack 139
monitor port 136
network jack 139
RJ-11 139
RJ-45 jack 139
Universal Serial Bus (USB)

port 140
plastic parts 33
Plastics Kit

contents 25
spare part number 23,  25,

31
plastics kit, spare part number 25
pointing device

product description 4
pointing stick buttons,

identifying 7
pointing stick, identifying 7
port options

1394 port 98
ExpressCard slot 98
flash media reader 98
parallel port 98

serial port 98
Smart Card slot 98
USB port 98

ports
1394 14
eSATA 15
external monitor 14
product description 3
USB 14,  15

power button, identifying 10
power connector, identifying 14
power cord

set requirements 141
spare part numbers 27,  28

power lights, identifying 8,  13
power requirements, product

description 4
presentation button,

identifying 11
processor

product description 1
removal 68
spare part numbers 22,  32,

68
processor heat sink

removal 66
spare part numbers 66

product description
audio 3
chipset 1
diskette drive 3
display panel 1
docking support 4
Ethernet 3
external media cards 3
graphics 1
hard drives 2
keyboard 4
memory module 2
microphone 3
modem module 3
operating system 4
optical drives 2
pointing devices 4
ports 3
power requirements 4
processors 1
product name 1
security 4

serviceability 5
wireless 3

product name 1

R
RAID (Redundant Array of

Independent Disks) devices 96
recovery partition 131
release latch, battery 16
removal/replacement

preliminaries 33
procedures 39

restore security defaults 98
restore the factory settings 93
restoring the hard drive 131
RJ-11 (modem) jack,

identifying 15
RJ-11 jack

pin assignments 139
RJ-11 jack cable

illustrated 26
RJ-45 (network) jack,

identifying 15
RJ-45 jack

pin assignments 139
RJ-45 jack cable

illustrated 26
RTC battery

removal 58
spare part number 28,  58

Rubber Kit, spare part
number 23,  31

run-in test 95

S
SATA (Serial Advanced

Technology Attachment) devices
AHCI (Advanced Host Controller

Interface) 96
IDE (Integrated Drive

Electronics) 96
Screw Kit

contents 111
spare part number 28,  31

screw listing 111
scroll zone, TouchPad 7
Secondary Battery Fast

Charge 97
security cable slot, identifying 14
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Security menu
always prompt for HP SpareKey

enrollment 94
Automatic DriveLock 94
change password 94
Disk Sanitizer 94
DriveLock 94
fingerprint reader reset 94
HP Sparekey 94
HP Sparekey enrollment 94
password policy 94
set up BIOS Administrator

password 94
System IDs 94
TPM embedded Security 94
user management 94

security, product description 4
serial number 39
service considerations 33
service tag 18
serviceability, product

description 5
set security level 98
setup utility

accessing 91
Diagnostics menu 95
File menu 93
navigating and selecting 91
restoring factory settings 92
Security menu 94
System Configuration

menu 96
slots

business card 14
ExpressCard 14
memory module 16
security cable 14
smart card reader 14
WLAN 16

smart card reader, identifying 14
speaker assembly

removal 83
spare part number 22,  31,

83
speaker, identifying 13
specifications

Blu-ray ROM DVD+/-RW
SuperMulti DL Drive 104

computer 99
display 100,  101,  102

DVD-ROM Drive 106
DVD-RW Drive 105
DVD±RW and CD-RW Combo

Drive 105
hard drive 103
I/O addresses 109
interrupts 108
memory map 107
optical drive 104,  105,  106
system DMA 107

start-up test 95
static-shielding materials 37
switch cover

removal 59
spare part number 21,  29,

59
system board

removal 85
spare part numberS 85
spare part numbers 22,  29,

32
System Configuration menu 96
system date and time 93
System Diagnostics menu 95
system DMA 107
system fan 96
system IDs 94
system information 93
system memory map 107

T
thermal material,

replacement 63,  65,  67
tools required 33
top cover

removal 78
spare part numbers 21,  29,

78
TouchPad buttons,

identifying 7
TouchPad scroll zone,

identifying 7
TouchPad, identifying 7
transporting guidelines 36
Trusted Platform Module

Embedded Security 94
TXT (Intel Trusted Execution

Technology) 97

U
Unified Extensible Firmware

Interface (UEFI) mode 97
Universal Serial Bus (USB) port

pin assignments 140
unknown password 38
upgrade bay, identifying 15
USB legacy support 96
USB ports, identifying 14,  15
USB/eSATA board

removal 82
spare part number 21,  29,

82

V
vents, identifying 14,  16
Virtualization Technology 97
volume down light, identifying 8
volume mute button,

identifying 11
volume mute light, identifying 8
volume scroll zone, identifying 11
volume up light, identifying 8

W
webcam light, identifying 6
webcam, identifying 6
Windows applications key,

identifying 12
Windows Backup utility 133
Windows logo key, identifying 12
Windows recovery 134
Windows Vista operating system

DVD 132
wireless antennae

disconnecting 51
wireless button, identifying 11
wireless light, identifying 8,  13
wireless, product description 3
WLAN module

removal 51
spare part numbers 22,  28,

51
workstation guidelines 36
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